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ハンドブック

このハンドブックはMuseScoreバージョン0.9.2以上のために書かれています。ハンドブッ

クを改善したり翻訳するためには、MuseScore Translation フォーラムに投稿し、ハ

ンドブック寄稿者になることを申し出てください。
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http://www.musescore.org/en/forum/9
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章1

はじめに

この章では、はじめてのMuseScoreインストール・実行を手伝います。 また、スコアの

新規作成の方法についても案内します。

インストール

Windows

MuseScoreウェブサイトのダウンロードにWindows用インストーラへのリンクがあります。

ダウンロードを開始するために、リンクをクリックしてください。インターネットブ

ラウザはこのファイルをダウンロードしたいかを確認します。"ファイルを保存する"を

クリックしてください。

ダウンロードが終わったら、インストールを開始するためにダブルクリックしてくださ

い。Windowsはセキュリティウィンドウでソフトウェアを実行するか尋ねてくるかもし

れません。続けるために"実行する"をクリックしてください。

インストーラは作業を続ける前に他のすべてのアプリケーションを閉じるよう勧めます。

他のアプリケーションを閉じた後に"Next（続ける）"をクリックしてください。

http://musescore.org/ja/%e3%83%80%e3%82%a6%e3%83%b3%e3%83%ad%e3%83%bc%e3%83%89
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セットアップウィザードは、あなたにとって再度見直すことになるフリーソフトウェア

ライセンスの条項を表示します。続けるために"I Agree（同意する）"をクリックして

ください。

次にMuseScoreをインストールする場所を確認してください。既にインストールされて

いる古いバージョンを保持したまま新しいバージョンをインストールする場合には、フォ

ルダを変更してください。そうでなければ、続けるために"Next（次へ）"をクリック

してください。

次にWindowsスタートメニューのプログラムリストに表示されるMuseScoreフォルダの名

前を確認してください。 続けるために"Install（インストール）"をクリックしてくだ

さい。

必要なファイルをインストールし設定するために、セットアップウィザードに数分かか

ります。それが終わったら、インストーラーを終了するために"Finish（終了）"をクリッ

クしてください。必要ならば、このときダウンロードしたインストーラーファイルを

削除してもよいでしょう。

MuseScoreをはじめる

MuseScoreをはじめるために、スタート → すべてのプログラム（P） → MuseScore 0.9 → M

useScoreを選択してください。 

数秒後、MuseScoreはデモ・スコアを開きます。 デモ・スコアを自由に試し、このプロ

グラムの感覚をつかんでください。次に、スコアの新規作成に進みましょう。.
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MacOSX

インストール

MuseScoreウェブサイトのダウンロードページにMac用dmgファイルがあります。ダウン

ロードを開始するためにリンクをクリックしてください。ダウンロードが終わったら、

dmgファイルは"MuseScore-0.9.5"として自動的にデスクトップにマウントされ、インス

トーラーが現れます。

MuseScoreアイコンをドラッグし、アプリケーションフォルダのアイコンへドロップし

てください。あなたが管理者ではない場合には、MacOSXはパスワードを尋ねてきます。

これでアプリケーションまたはSpotLightからMuseScoreを起動できます。

アンインストール

アプリケーションフォルダからMuseScoreを削除してください。

Linux

Fedora向けのインストール手順については以下を参照してください。 

MuseScoreのインストール

http://musescore.org/ja/%e3%83%80%e3%82%a6%e3%83%b3%e3%83%ad%e3%83%bc%e3%83%89
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プロジェクトのソースhttp://www.musescore.org/en/downloadから入手できますが、通

常は、あなたの使っているディストリビューションに最適なバイナリパッケージが見つ

かるでしょう。Ubuntuでは、MuseScoreは"universe"レポジトリにあります。MuseScore

をインストールする場合、universeレポジトリを利用可能にしておく必要があります。

音声を出力するためには、ALSAあるいはJACK音声サーバを使うためのオプションを設定

してください。それぞれのシステムに応じて、どちらかが（より良好に）動作します。

MuseScoreをインストールするために、以下のステップをたどってください。

1. Add/Remove Software（Gnomeでは、Add/Remove Programs）を開いてください。

2. Multimediaカテゴリの中で（Gnomeでは、Sound & Video）、MuseScoreを選択して

ください。

3. "JACK Control"パッケージも選択してください。

4. Previewをクリックしてください。（KDEのみ）

5. Apply Changesをクリックしてください。

JACKサーバーの設定

"JACK Audio Connection Kit"を開き、Setupを選択してください。

1. audioタブの中の"realtime"をはずしてください。

2. ALSA audioを使う場合にはdriverに"ALSA"を設定し、I/O deviceに“hw:0”（hw:

Zero）を設定してください。いくつかのシステムでは、ALSAが動作せず、OSSが動

作するかもしれません。OSS audioを使用する場合には、driverに"oss"を、I/O de

viceに"/dev/audio"を設定してください。

3. 変更を適用し、JACKサーバを開始してください。

MuseScoreの設定

MuseScoreを設定するために以下のステップをたどってください。

1. メインメニューのMultimedia（Gnomeでは、Sound & Video）の中から、Muse Scor

eを開いてください。

2. Editメニューを開き、Preferencesを選択してください。

3. I/Oタブの中で、 

1. "Use internal synthesizer"にチェックが入っていることを確認してくださ

い。

2. SoundFontが/usr/share/sounds/sf2/FluidR3_GM.sf2（これはデフォルトです）で

あることを確認してください。 または、もし追加のSoundFontをインストール

しているのであれば、個人のSoundFontを選択してください。

3. ALSA audioを使用する場合には、driverを"ALSA"に設定し、deviceをhw:0（hw:

Zero）に設定してください。それ以外の場合には、ALSAをはずし、JACK audi

oサーバを有効にしてください。

4. Applyをクリックし、次にOKをクリックしてください。

5. MuseScoreを閉じ、次にあなたの音楽を書き始めるために開き直してください。

http://www.musescore.org/en/download


6 

注釈

• AmarokやRhythmboxといった音楽プレーヤーの選択では、JACKが実行中に同時に音

楽を再生することができません。音楽を止めるか、もしかするとJACKサーバを開始

するために音楽プレーヤーを閉じる必要があるでしょう。しかしながら、音楽を再

び再生するためには、音楽プレーヤーを再使用するためにはJACKでStopを押す必要

しかありません。プレイバックを聞いている間にJackサーバを開始しようとすると、

JACK Connection GUIはハングするでしょう。

MIDIに関する問題に遭遇した場合、あなたのシステムはMIDIを再生するように設定

してないかもしれません。ConsoleあるいはTerminalから、次のコマンドを入力し

てください。

sudo modprobe snd-seq

sudo su -c 'echo snd-seq >> /etc/modules'

• 特にJackサーバは、適切に設定されていないならばハングしてややこしいものに

なります。もしハンドブックで解決できなかった問題に遭遇した場合には、次のい

ずれか、もしくはすべてのウェブページに相談してください。 

• https://help.ubuntu.com/community/ubuntustudiopreparation

• https://help.ubuntu.com/community/howtoqjackctlconnections

• https://help.ubuntu.com/community/howtojackconfiguration

Fedora

GPG keyのインポート:

su

rpm --import http://prereleases.musescore.org/linux/Fedora/RPM-GPG-KEY-Seve

2. MusScoreウェブサイトのダウンロードページに進んでください。Click on the li

nk for the stable 安定版Fedoraについてのリンクをクリックし、あなたの使用す

るアーキテクチャに合ったrpmパッケージを選んでダウンロードしてください。 

3. あなたのアーキテクチャによって、MuseScoreをインストールするための２組のコ

マンドのうち１つを使用してください。 

i386アーキテクチャの場合

su

yum localinstall musescore-0.9.4-1.fc10.i386.rpm

またはx86_64アーキテクチャの場合

su

yum localinstall musescore-0.9.4-1.fc10.x86_64.rpm

音声出力に問題がある場合には、Fedora 11 and soundを参照してください。

https://help.ubuntu.com/community/ubuntustudiopreparation
https://help.ubuntu.com/community/howtoqjackctlconnections
https://help.ubuntu.com/community/howtojackconfiguration
http://musescore.org/ja/%e3%83%80%e3%82%a6%e3%83%b3%e3%83%ad%e3%83%bc%e3%83%89
http://www.musescore.org/en/node/3848#comment-9634
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スコアの新規作成

メインメニューから File → New...を選択すると新規作成ウィザードが開きます。

曲名、作曲者、その他の情報

上図のように、title(曲名)、composer(作曲者)、その他の情報を入力します。画面下

の2つの選択肢に注意してください。

• Create new score from template

• Create new score from scratch

初めの選択肢を選ぶと、次のウィンドウで、楽器の編成を用意された楽譜のテンプレー

トから選ぶことが出来ます。2番目の選択肢にすると、次のウィンドウで全ての楽器を

自由に選ぶことが出来ます。テンプレートに関しては 以下を参照してください。本項

では"Create new score from scratch."を選んだ場合について述べます。

"Next" をクリックして続けます。

楽器と声部
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楽器ウィンドウは2つのカラムに分かれています。左側のカラムは選択可能な楽器のリ

ストで、右側のカラムには初めは何も表示されていませんが、作成する楽譜で用いる楽

器が表示されます。

左側のカラムの楽器リストは楽器の種類ごとに分類されています。種類名をダブルクリッ

クすることで、その種類の全ての楽器が表示されます。楽器を選び "Add" をクリッ

クすると、右側のカラムに選んだ楽器が追加されます。必要なだけ楽器や声部を追加で

きます。

右側のカラムでの楽器の並び順が、楽譜での並び順になります。順番を変えるには、楽

器名をクリックしてから "Up" または "Down" ボタンをクリックすることで上下に移動

が可能です。楽器の設定が終わったら、 "Next" をクリックして次へ進みましょう。

調号

最新のMuseScoreを使っている場合は調号の設定ウィンドウが表示されるので、適切な

調号を選び "Next" をクリックして次へ進んでください。

version 0.9.2以前を使っている場合は調号の設定は無いので、このステップは無視し

てください。

拍子記号、弱起、小節の数
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適切な拍子記号を設定してください。弱起で始まる曲の場合は、 "Pickup mesure" チェ

ックボックスをチェックし、弱起の拍子記号を設定して最初の小節の長さを決めてく

ださい。

必要な小節数のおよその数がわかっていれば、ここで指定できます。不明の場合でも、

後で小節の増減は可能です。

"Finish" をクリックすると楽譜が作られます。

作成した楽譜の調整

新規作成ウィザードで設定した全ての項目はいつでも変更できます。

• 小節の増減や弱起の作成については小節の操作の項目を参照してください。

• テキストの変更についてはテキスト編集の項目を参照してください。未設定の曲

名(あるいは他のテキスト)を追加するには、メニューのCreate → Text → Title (あ

るいは他のテキストの項目)から行えます。

• 楽器の追加、削除、並び順の変更は、メニューのCreate → Instruments...から行え

ます。

関連項目: 調号, 拍子記号, 音部記号.

テンプレート

新規作成ウィザードの最初の画面で、 "Create new score from template" という選択

肢があります(詳しくはこのページ上部の 曲名、作曲者、その他の情報の項を参照して

ください)。テンプレート使用の選択肢を選び、"Next" をクリックして次へ進んで見ま

しょう。 

次の画面でテンプレートを選び、"Next" をクリックし、同様に新規作成ウィザードを

進め、完了してください。

テンプレートファイルは通常のMuseScoreファイル形式でテンプレートフォルダに保存 

されています。テンプレートフォルダにMuseScoreファイルを保存することで、独自の 

テンプレートを作成できます。Windowsの場合、テンプレートフォルダのパスは通常C:\
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Program Files\MuseScore 0.9\templatesです。Linuxの場合、パッケージマネージャー

 からインストールした場合には、/usr/share/mscore-xxxを見てください。Linuxでmsc

o reをコンパイルした場合、/usr/local/share/mscore-xxx以下を見てください。
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章2

基本

これまでの"はじめに"の章では、インストールとスコアの新規作成の手順を通してガイ

ドしてきました。"基本"の章では、MuseScoreの概要を示し、スコアと付き合うための

一般的な方法を述べます。

音符の入力

音符は音符入力モードで入力できます。まず、音符を入力したい位置に既に存在する音

符や休符を選択してください。音符を入力すると既存の音符や休符は、新しく入力され

たものと置き換わります。そのため、小節の長さは変化しません。

• N: 音符入力モードを開始します。

• Escape : 音符入力モードを終了します。

音符入力モードでは、入力したい音符の長さを音符パレットから選ぶか、以下のショー

トカットキーを用いて音符を入力します。 

version 0.9.4以降での音符の長さを選ぶショートカットキーは次の通りです。

• 1: 64分音符

• 2: 32分音符

• 3: 16分音符

• 4: 8分音符

• 5: 4分音符

• 6: 2分音符

• 7: 全音符

• 8: 倍全音符

• 9: Longa(全音符4つ分)

• .: 付点音符へ変更
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version 0.9.3以前では2つのキーからなるショートカットキーを用います。

• Alt+1: 4分音符

• Alt+2: 8分音符

• Alt+3: 16分音符

• Alt+4: 32分音符

• Alt+5: 64分音符

• Alt+6: 全音符

• Alt+7: 2分音符

• .: 付点音符へ変更

音符はキーボードによって入力できます。 (例) C D E F G A B C

Space を入力すると休符になります。 (例) C D Space E選んだ音符の長さ（この例では、

４分音符）で休符の長さも決まる（この場合４分休符）ことに注意してくささい。

Shift を押したまま音符を入力することにより、和音になります。 (例) C D Shift+F Shif

t+A E F

付点音符を入力するには次のようにします。 (例) 5 . C 4 D E F G A (注意: versions 

0.9.3以前では音符の長さを変えるショートカットキーは異なります。詳しくは上の項

目を見てください。)

オクターブを変更するには次のショートカットキーを用います。

• Ctrl+Up (Mac: ⌘+Up): 1オクターブ上げる。

• Ctrl+Down (Mac: ⌘+Down): 1オクターブ下げる。

その他に次のショートカットキーがあります。

• x: 符幹（ぼう）の向きを反転させます。

• Shift+x: 符頭（たま）を符幹（ぼう）をはさんで反対側に移動します(水平反転)。

MIDIキーボード

version 0.9.4以降では、WindowsまたはLinux環境において、MIDIキーボードを用いる

ことにより音程を入力することができます。 Version 0.9.3以前では、MIDIキーボード

はLinuxにおいてのみ使用可能です。
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色

MuseScoreは、バージョン0.9.5以降では、黄色または赤色が音域外の音符として色付け

されます。アマチュアに適した音域の上下にある音符は黄色で表示され、プロフェッショ

ナルに適した音域を越える音符は赤色で表示されます。この色はコンピュータのスク

リーン上では情報を表わしますが、スコアの印刷物には表示されません。バージョン0.

9.6以降で音符の色を使用不可にするためには、Edit → Preferences...を選び、Note Entr

yタブをクリックし、"Color notes outside of usable pitch range"のマークを外して

ください。 

外部リンク

• ビデオチュートリアル: 音符入力の基本 by Katie Wardrobe

コピーと貼り付け

MuseScoreでは個々の音符や音楽の広い範囲を指定してコピーできます。0.9.4リリース

はシフト-ドラッグ選択のためのサポートを含むコピー・貼り付けに対する多くの改善

を含んでいます。 バージョン0.9.3以前でのコピー・貼り付けは、完全な小節に限られ、

使用が困難でした（以下の手引きを参照のこと）。

コピー

1. 範囲の最初の音符をクリックしてください。

2. 範囲の最後の音符でShift+クリックしてください。青い長方形が選択した領域を反転

させているはずです。

3. メニューからEdit → Copyを選択してください。

貼り付け

1. 貼り付けを始めたい場所の音符か小節をクリックしてください。

2. メニューからEdit → Pasteを選んでください。

0.9.3以前のための手引き

コピー

1. 小節の空白部分から完全な小節までクリックしてください。（青い長方形で範囲

が反転されます。）

2. 範囲を拡張したい場合は、その他の小節の空白部分でShift+クリックしてください。

3. メニューからEdit → Copyを選択してください。

貼り付け

1. 貼り付けたい小節の空白部分をクリックしてください。

2. メニューからEdit → Pasteを選択してください。

http://musictechtips.wordpress.com/2010/01/31/musescore-in-10-easy-steps-part-3-note-entry-basics/
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編集モード

スコアの多くの要素は編集モード（訳注: 英語版MuseScoreでは、ステータスバーにはe

dit modeと表示されます。）から編集できます。

• ダブル・クリック: 編集モードを開始します。

• Escape: 編集モードを終了します。

編集モードでは、いくつかの要素には、マウスのドラッグやキーボード・コマンドで動

かせるハンドル（□や■）が表示されます。

編集モードでのスラー:

使用可能なキーボード・コマンド:

• Left: ハンドルを１スペース分左へ移動します。

• Right: ハンドルを１スペース分右へ移動します。

• Up: ハンドルを１スペース分上へ移動します。

• Down: ハンドルを１スペース分下へ移動します。

• Ctrl+Left (Mac: ⌘+Left): ハンドルを0.1スペース分左へ移動します。

• Ctrl+Right (Mac: ⌘+Right): ハンドルを0.1スペース分右へ移動します。

• Ctrl+Up (Mac: ⌘+Up): ハンドルを0.1スペース分上へ移動します。

• Ctrl+Down (Mac: ⌘+Down): ハンドルを0.1スペース分下へ移動します。

• Shift+Left: ハンドルのアンカーを左へ移動します。

• Shift+Right: ハンドルのアンカーを右へ移動します。

• Tab: 次のハンドルへ切り替えます。

関連項目: テキスト編集、スラー、括弧、線

小節の操作

追加

曲の最後に小節を追加するためには、Ctrｌ+B（Mac: ⌘+B）を押してください。複数の小

節を追加するためには、メニューからCreate → Measures → Append Measures...を使用し

てください。

挿入

sures...を使用してください。
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削除

小節を削除するには、まず最初に特別な方法で小節を選択しなければなりません。Ctrl 

(Mac: ⌘)を押しながら、小節の中の空白の部分をマウスでクリックします。すると、小

節の全体が破線で囲まれますのでDel (Mac: Fn+Backspace)を押してください。すると、破

線で囲まれた小節全体が削除されます。

プロパティ

小節のプロパティを編集するためには、その小節の空白部分で右クリックし、Measure P

roperties...を選択します。

譜表（Staves）

可視（Visible）プロパティでは、現在の小節について音符と小節線を表示するか隠す

かを設定します。符尾なし（Stemless）プロパティでは、現在の小節について、すべて

の符尾を表示するか隠すかを設定します。通常は、２分音符や４分音符のような符尾だ

けが、符尾なしにマークしたときに符頭だけになることに注意してください。

小節の演奏時間（Measure Duration）

名目の（Nominal）小節演奏時間は、スコアに表示される拍子記号です。実際の（Acctu

al）小節演奏時間は、スコア上に表示された拍子記号に関わらず変更できます。通常は、

名目および実際の小節演奏時間は等しいです。上拍の（アップビートの）小節は実際

の演奏時間をより短く設定できます。

不規則な小節（Irregular）

"不規則"小節は、小節番号には数え上げられません。通常は、上拍小節が"不規則"とし

てマークが付されます。バージョン0.9.4以前を使用し、小節を不規則としてマークす

る場合には、小節番号が変化する前に保存とリロードが必要となります。

繰り返し回数（Repeat）

小節が繰り返しの終了である場合、何回繰り返すのかを定義できます。

複小節にわたる全休符の分割（Break multi-measure rests）

けます。



16 

パレット

メニューのDisplay → Paletteからパレットを表示または隠すことができます。

パレット記号をスコアの要素にドラッグ・アンド・ドロップできます。

パレット記号のダブルクリックは、スコア上で選択された要素へ、この記号をドラッグ・

アンド・ドロップすることと同じです。

例えば、テヌートを一度に複数の音符上へ簡単に置くことができます。

1. 音符を選択してください。

2. アーティキュレーション/装飾音パレット上でテヌート記号をダブルクリックして

ください。

元に戻すと繰り返し

MuseScoreには無制限の元に戻す（Undo）/繰り返し（Redo）機能があります。

標準的なショートカット:

• 元に戻す Ctrl+Z（Mac: ⌘+Z）

• 繰り返し Ctrl+Shift+Z または Ctrl+Y（Mac: ⌘+Shift+Z）

またはツールバーのボタンの使用:

エクスポート

スコアはFile → Save As...から、いくつかの異なるフォーマットにエクスポートできま

す。

圧縮MuseScoreフォーマット（*.mscz）

MSCZは標準的なMuseScoreファイルフォーマットで、ほとんどの用途に推奨されま

す。このフォーマットで保存されたスコアでは、どの情報も失われないでしょう。

このフォーマットは、.mscファイルがZIPで圧縮されたバージョンです。

MuseScoreフォーマット（*.mscx）

いられていました。しかし、MSCはMicrosoft Windowsのファイル拡張子と競合して

 いて、いくつかのemailプロバイダからブロックされている。新しいMSCXファイル

 拡張子は、上に概説した問題のため、古いMSCファイル拡張子に取って代わります。
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MusicXML（*.xml）

MusicXMLは楽譜の世界標準であり、Sibelius、Finale、その他１００以上の現在使

用可能なほとんどの楽譜作成ソフトウェアで使用できます。楽譜を異なる楽譜作成

ソフトウェア間で共有するために、推奨されるフォーマットです。

圧縮MusicXML（*.mxl）

圧縮MusicXMLは標準のMusicXMLより小さなファイルを作成します。圧縮MusicXMLは、

新しい標準であり、現時点では他の楽譜作成ソフトウェアで広くサポートされて

いません。

MIDI（*.mid）

Musical Instrument Digital Interface（MIDI）は、シーケンサーや楽譜作成ソフ

トウェアで広くサポートされているフォーマットです。しかし、MIDIファイルはス

コアのレイアウトのためではなくプレイバックのために設計されており、そのため

フォーマット、ピッチの表記、声部、装飾音、アーティキュレーション、繰り返し、

あるいは拍子記号やそれらにまたがることに関する情報を含んでいません。異な

る楽譜作成ソフトウェア間でファイルを共有するためには、MusicXMLを使用してく

ださい。プレイバックしか気にかけない場合には、MIDIを使用してください。

PDF（*.pdf）

Portable Document Format（PDF）は、音楽を編集する必要のない他の人と楽譜を

共有するための理想的なものです。ほとんどのコンピュータのユーザーは、すでに

PDFビューワーを持っているため、スコアを見るために余計なソフトウェアのイン

ストールを必要としないでしょう。

PostScript（*.ps）

PostScript（PS）は、印刷に用いられるページ記述言語として広く普及しています。

PNG（*.png）

Portable Network Graphics（PNG）は、主要なすべてのオペレーティング・システ

ムでネイティヴにサポートされているビットマップ・イメージ・フォーマットです。

バージョン0.9.3で、複数ページスコアが各ページのPNGファイルにエクスポート

されるようになりました。

SVG（*.svg）

Scalable Vector Graphics（SVG）は、ほとんどのウェブ・ブラウザ（Internet Ex

plorerが期待される）とベクター・グラフィックス・ソフトウェアで開くことがで

きます。しかし、ほとんどのSVGソフトウェアは埋め込みフォントをサポートして

いないため、これらのファイルを正しく見るためには適切なMuseScoreフォントを

インストールしなければなりません。

LilyPond（*.ly）

http://www.recordare.com/xml.html
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LilyPondフォーマットは、Lilypond楽譜作成ソフトウェアで開くことができます。

しかし、LilyPondエクスポートは現行バージョンのMuseScoreでは、不完全で実験

的なものです。

WAV オーディオ（*.wav）

WAV（Waveform Audio Format）はMicrosoftとIBMによって開発された非圧縮の音声

フォーマットですが、Windows、Mac OS、Linuxのためのソフトウェアから幅広くサ

ポートされています。ファイル保存の過程で音質が一切失われないため、これはCD

を作成するには理想的なフォーマットです。しかし、大きなファイルサイズのため

にEメールやウェブを通じて共有することが困難です。このエクスポートオプショ

ンはバージョン0.9.5以降で使用可能です。

FLACオーディオ（*.flac）

Free Lossless Audio Codec（FLAC）は圧縮オーディオ・フォーマットです。FLAC

ファイルは、音質が良いままで非圧縮オーディオのおよそ半分のサイズになります。

WindowsとMac OSではFLACに対するビルト・インのサポートはありませんが、VLC

 media playerのようなソフトウェアによって、どのオペレーティング・システム

でもFLACファイルを再生できます。このエクスポートオプションはバージョン0.9.

5以降で使用可能です。

Ogg Vorbis（*.ogg）

Ogg Vorbisは、広く普及しているMP3オーディオフォーマットに代わって、パテン

ト・フリーな後継になろうと意図しています。Ogg Vorbisファイルは、比較的小さ

い（しばしば、非圧縮オーディオの１０分の１になります）が、いくつかの音質は

失われます。WindowsとMac OSはOgg Vorbisのためのビルト・インのサポートを持っ

ていません。. しかし、VLC media playerのようなソフトウェアとFirefox 3.5

以降であれば、どのオペレーティング・システムでもOggファイルを再生すること

ができます。このエクスポートオプションはバージョン0.9.5以降で使用可能です。

http://lilypond.org
http://www.videolan.org/vlc/
http://www.videolan.org/vlc/
http://www.videolan.org/vlc/
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章3

記譜

前の"基本"の章では、音符の入力の方法とパレットとの付き合い方を学びました。 こ

の"記譜"の章では、より複雑な音楽記法を含む、様々な種類の記譜をさらに詳しく述べ

ます。

臨時記号

臨時記号（Accidentals）は、accidentalパレットからスコア上の音符に臨時記号をド

ラッグすることで、設定や変更ができる。

ピッチの変更をしたいだけならば、その音符を選択し以下のキーを押してください。

• Up: 半音ずつ音符のピッチを上げます。

• Down: 半音ずつ音符のピッチを下げます。

• Ctrl+Up: １オクターブずつ音符のピッチを上げます。

• Ctrl+Down: １オクターブずつ音符のピッチを下げます。

MuseScoreは変更されたピッチに適した臨時記号を自動的に設定しようとします。 臨時

記号を手動で訂正したり、注意を促すための臨時記号（cautionary accidental、また

は編集上の臨時記号editorial accidental）を置く必要のある場合には、accidentalパ

レットから音符へドラッグしてください。もし後でカーソルキーでピッチを変更した場

合、臨時記号の手動設定は失われます。
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メニューの機能Notes → Pitch spellは全スコアの正しい臨時記号の推測を試みます。

アルペッジョ

アルペッジョ（Arpeggios）は、arpeggioパレットから和音の音符へアルペッジョ記号

をドラッグすることで設定されます。

バージョン0.9.5以降では、ダブルクリック後にハンドルを上下にドラッグすることで

アルペッジョの長さを編集することができます。

小節線

小節線の変更

小節線（Bar lines）は、 bar lineパレットの小節線記号をスコアの小節線へドラッグ

することで変更されます。 

小節線を完全に隠すためには、線の上で右クリックし、Set Invisibleを選んでください。

.

大譜表の作成

複数の譜表にまたがった小節線を延ばすためには、編集するために線の上でダブルクリッ

クしてください。（関連: 編集モード）
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青い四角形を下の譜表に向けてドラッグしてください。編集モードを終了したとき、す

べての小節線の表示が更新されます。

関連項目: 小節の操作

連桁

連桁（Beams）は自動的に設定されますが、自動設定は手動で無効にできます。連桁の

様式をへんこうするには、beamパレットから音符へ連桁記号をドラッグしてください。

まず音符を選択し、beamパレットにある適切な記号をダブルクリックすることもできま

す。 この音符から連桁を開始 この音符で連桁を終了 この音符の連桁を解除

この音符で第２レベルの連桁を開始

関連項目: 譜表をまたぐ連桁

括弧

削除

括弧を選択し、Delを押してください。

追加

bracketパレットから譜表の最初の小節の空白へ、括弧記号をドラッグしてください。

変更

bracketパレットからスコアの括弧へ、括弧記号をドラッグしてください。

水平方向のオフセット

バージョン0.9.4以降では、括弧の水平位置を調節できます。括弧をダブルクリックし、

左または右に移動するためにShift+LeftまたはShift+Rightを押してください。
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編集

編集モードに入るために括弧をダブルクリックしてください。編集モードでは、譜表内

で任意の五線をつなぐ括弧の高さをドラッグできます。

ブレス

ブレス（breath）記号を配置するためには、ブレス記号をbreathパレットからスコア上

の音符へドラッグしてください。 ブレス記号が音符の直後に置かます。バージョン0.9.

5以前では、ブレス記号はドラッグした音符の直前に表示されます。

スコア上のブレス記号: 

音部記号

音部記号（Clefs）は、clefパレットから小節あるいは他の音部記号へドラッグするこ

とで作成または変更される。パレットサイドバーの表示・非表示のために、F9を使用し

てください。

変更
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パレットからスコア上の音部記号へ、音部記号をドラッグしてください。Shift + 左マウ

スボタン + ドラッグを使用して、音部記号をスコアからスコアの他の音部記号上へドラッ

グすることもできます。.

追加

音部記号をパレットから小節の空白部分へドラッグしてください。この操作では、小節

の最初に音部記号を作成します。小節の途中で始まる音部記号を作成するためには、特

定の音符へ音部記号をドラッグしてください。その小節が譜表の最初の小節ではない場

合には、その音部記号は小さめに描画されます。

削除

音部記号を選択し、Delを押してください。

音部記号の変更は音符のピッチを変更しないことに注意してください。その代わりに音

符が移動します。

譜表をまたぐ連桁

ピアノスコアでは、音楽のフレーズを書くために両方の譜表（低音部譜表と高音部譜表）

を使うことが普通です。MuseScoreでは、次のように入力できます。

まず１つの譜表にすべての音符を入力してください。 

Ctrl+Shift+Downで選択された音符または和音を次の譜表へ移動させてください。（Mac: ⌘

+Shift+Down）

関連項目: 譜表をまたぐ小節線（例えば、大譜表）については小節線

打楽器の記譜
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打楽器の記譜の例:

ドラムセットに関する記譜では、上向き符尾と下向き符尾の音符を同時に含むことがよ

くあります。もし１つ譜表で複数の声部を編集することに慣れていなけれ、概要につい

て声部を参照してください。打楽器の記譜に特有の手順については、以下を見てくださ

い。

MIDIキーボード

あなたのスコアに打楽器の記譜を追加する最も簡単な方法は、MIDIキーボードによるも

のです。ほとんどのMIDIキーボードには、それぞれのキーの上に打楽器マークが付いて

います。ハイハットについてのキーを押せば、MuseScoreはスコア上に正しい記譜を追

加するでしょう。MuseScoreは、符尾の方向と符頭の種類を自動的に処理します。

マウス

バージョン0.9.4以降では、マウス操作での入力が利用可能であることに注意してくだ

さい。

1. 打楽器の譜表で、音符または休符を選択してください。この作業で対応するdrum

パレットを読み込みます。

2. 音符入力を開始するために、"N"を押してください。

3. 音符入力ツールバーから、音符の長さを選択してください。

4. drumパレットから音符の（バスドラムかスネアといった）種類を選択してくださ

い。

5. スコアに音符を追加するために、打楽器の譜表をクリックしてください。

装飾音

短前打音（Acciaccatura） は、符尾にスラッシュが付いた小さな音符として表されま

す。長前打音 （Appoggiatura）にはスラッシュはつきません。 両方とも、ふつうの大

きさの主要音の直前に置かれます。 

装飾音記号をnotesパレットからスコア上の普通の音符へドラッグすることで、装飾音

を作成してください。

http://musescore.org/en/handbook/voices
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関連項目: Wikipedia 装飾音

ヘアピン

ヘアピン（Hairpin）は線図形です。ヘアピンを作成するためには、まず開始地点をマー

クするために音符を選択してください。

• H: クレッシェンド用ヘアピンを作成します。

• Shift+H: ディミヌエンド（デクレッシェンド）用ヘアピンを作成します。

lineパレットからヘアピン記号を符頭にドラッグすることでヘアピンを作成できます。

H でクレッシェンド用ヘアピンを作成してください。

ダブルクリックし編集モードへ切り換えてください。

Shift+Rightでアンカーを移動してください。

Rightで終了地点まで移動してください。

調号

http://ja.wikipedia.org/wiki/%e8%a3%85%e9%a3%be%e9%9f%b3
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調号（Key signatures）は、調号記号をkeyパレットから小節あるいは既存の調号へド

ラッグすることで作成または変更します。

F9でパレットウィンドウを切り換えます。

変更

パレットからスコア上の調号へ調号をドラッグしてください。Shift+左マウスボタン+ドラッ

グを用いて、スコアから調号をスコア上の他の調号へドラッグすることもできます。

追加

パレットから小節の空白部分へ調号をドラッグしてください。この操作は、小節の最初

に調号を作成します。

削除

調号を選択し、Delを押してください。

線

線（lines）パレットは、パレットと同様に"ドラッグ・アンド・ドロップ"により動作

します。パレットから項目をドラッグし、スコア上にドロップするようにマウスを使用

してください。

長さの変更

マウスを使用して線の長さを変更したい場合には、アンカー位置（音符や小節が適用さ

れている）が変更されない。そのため、以下の方法は、線の始点と終点を調節する方法

として推奨する。 
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1. 音符入力モードに入っている場合、音符入力を終了するためにNを押してください。

2. 変更したい線をダブルクリックしてください。

3. 次のショートカットを使ってハンドルを移動してください。 

• Shift+Right １音（または小節）分アンカーを右に移動します。

• Shift+Left １音（または小節）分アンカーを左に移動します。

4. 線がアンカーされている音符や小節を変更せずに、見かけ上の長さを変更する必

要がある場合、次のショートカットを使用してください。 

• Right １単位分ハンドルを右に移動します

• Left １単位分ハンドルを左に移動します

関連項目: ヘアピン, 反復記号（１番括弧、２番括弧）

全休符

全休符

小節全体に音符が全く無いときは、全小節（全音符）の休符として全休符が用いられま

す。

全休符を作成するためには、小節を選択しDelを押してください。この小節にあったすべ

ての音符と休符は全休符に置き換えられます。

複小節にわたる全休符

複小節にわたる全休符は、楽器のための長い時間の沈黙を表し、アンサンブルの楽譜で

よく用いられます。バージョン0.9.5以前では、この機能は実験的に過ぎません。（以

下の制限を参照）

手引き

1. メニューからStyle → Edit General Styleを選んでください。（バージョン0.9.5以

前では、Style → Edit Styleと呼ばれています。）

2. "Score"タブが選択されていない場合には、"Score"タブをクリックしてください。

 

3. "Create Multi Measure Rests"の次のチェックマークを加えてください。

制限

バージョン0.9.5以前では、二重小節線、調合、リハーサル記号などの重要な箇所で複 

小節にわたる休符を自動的に分割しません。これは既に次期バージョン0.9.6で解決さ
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れています。以前のバージョンで回避するためには、小節の操作の見出し"複小節にわ 

たる全休符の分割"を参照してください。

このスタイル・オプションは、自動的にスコア全体に複小節にわたる全休符を作ります。

そのため、まずすべての音符を入力し、その後に複小節にわたる全休符に変えること

を推奨します。

繰り返し

単純な繰り返しの始点と終点は、適切な小節線の設定により定義できます。１番括弧と

２番括弧の小節の説明については、反復記号を参照してください。

プレイバック

プレイバック中に繰り返しを聴くために、ツールバーの"Play Repeats" ボタンが

選択されていることを確かめてください。同様ｈに、そのボタンを外すことで、プレイ

バック中の繰り返しを切ることができます。

繰り返しの最後の小節では、繰り返しの演奏回数を定義するために、プロパティで"Rep

eat Count"を設定することができます。

テキスト

"D.C. al Fine"や"D.S. al Coda"のような繰り返しテキストはrepeatsパレット内に置

かれています。.

スラー

スラー（slur）は、切れ目なしに演奏することを示す２つ以上の音符間の曲線です。 

同じ音程の２つの音符を結ぶつもりなら、タイを参照してください。

手順

音符の入力モードを終了し、最初の音符を選択してください。 
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Sを押し、スラーを作成してください。

Shift+Rightで次の音符の終わりまでスラーを移動してください。

Xを押し、スラーの方向を反転させてください。

Escapeを押し、スラー編集モード（Slur Edit mode）を終了してください。

四角形またはハンドル（上のステップ２－４で図に示した）はマウスで調節できます。

外側の２つハンドルはスラーの始点と終点を調節します。内側の２つのハンドルはスラー

の輪郭を調節します。

スラーはいくつかの譜表やページにまたがることができます。スラーの始点と終点は音

符／和音、休符へアンカーされています。音符がレイアウト、範囲またはスタイルの変

化により再配置された場合、スラーも移動しサイズに合わせて調節されます。

注意: マウスを使って始点と終点のアンカーである音符を変更することはできません。

スラーの始点と終点を調節するためには、Shift + 左または右矢印キーを使用してくだ

さい。

関連項目: タイ、編集モード.

タイ

タイ（tie）は同じ音程の２つの音符の間にかかる曲線です。異なる音程にわたってい

る曲線を使いたい場合はスラーを参照してください。

方法１

最初の音符を選択してください。
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+でタイを作成します。（バージョン0.9.3以前では、このショートカットはShift+Sです。

）

方法２

音符の入力中にタイを作成するためには、タイの最初の音符の後で+を押します。 バー

ジョン0.9.3以前では、最初の音符を追加する前にを+押さなければなりません。

拍子記号

拍子記号（time signatures）はメインパレットのサイドバーから使用可能です。拍子

記号をスコアへドラッグ・アンド・ドロップできます（MuseScoreでのパレットの動作

についての一般的情報はパレットを参照してください）。

サイドバーパレットに見つからない拍子記号が必要な場合は、独自のものを作成するた

めにCreate → Time...へ移動してください。 Create Time Signatureペインで上部・

下部の数字を編集できます。. 

ほとんどの場合、上部の数字の最初を編集することだけでよいでしょう。追加の上部の

数字は、＋符号で分割された複数の上部の数字を含む変拍子です。

上拍小節（不完全小節）

http://ja.wikipedia.org/wiki/%e6%8b%8d%e5%ad%90#.e5.a4.89.e6.8b.8d.e5.ad.90
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小節の実際の時間が拍子記号で指定された時間と異なる場合があります。上拍小節はよ

くある例です。異なる拍子記号が表示されないように小節の実際の時間を変更するため

には、小節の操作のプロパティの節を参照してください。

トレモロ

トレモロ（tremolo）は、１つの音を素早く繰り返す、または２つ以上の音の間で素早

く交互に演奏することです。音符の符尾のスラッシュによろ指示されます。トレモロが

２つ以上の音符間にある場合、符尾はその間に描かれます。

tremoloパレットには、１音のトレモロの分割記号（以下に示した図の符尾のあるもの）

と２音のトレモロの分割記号（以下に示した図では符尾のないもの）.

２音のトレモロでは、各音符のトレモロは全トレモロの長さの値をもつ。２分音符の長

さをもつトレモロに入るためには、まず２つの普通の８分を入力します。はじめの音符

にトレモロ記号をドラッグしたあと、音価は自動的に２分音符に倍加されます。

連符

三連符を作成するために、まず三連符の全部の長さをもつ音符を１つ作成してください。

次にその音符を選択し、三連符に変更するためにCtrl+3を押してください。同様に、Ct

rl+5はその音符を五連符に変更します。

はじめに音符を選択してください。

Ctrl+3は三連符を作成します。

これをさらに編集できます。

音符入力モード

音符の入力モードにおける連符入力は、上記の方法とは少し異なった動作となります。

 バージョン0.9.5以降では、まず長さに気をつけ、その後音程の入力をしなければなり
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ません。次に示すのは、三連８分音符を作成するための手順です。

1. 音符入力モードを開始してください。

2. 音符入力のマーカーは連符を開始したい場所であるか確認してください（必要な

ら右矢印、左矢印キーを使ってください）。

3. 連符の全部の長さを指定するために、ツールバーから４分音符の長さを選択して

ください。

4. 連符のタイプを指定するために、メニューからNotes → Tuplets → Tripletを選ん

でください。

5. ８分音符の長さが自動的に選択されることに注意してください。音程を加えるた

めに譜表をクリックしてください。

プロパティ

連符の表示プロパティを変更するためには、連符の数字を右クリックしTuplet Propertie

s...を選択してください。

プロパティダイアログのnumberセクションでは、１つの整数か、２つの整数の比か、 

あるいは全く数字を表示しないかを選ぶことができます。

bracketセクションでは、"bracket"と"nothing"により括弧を厳密に表示するか隠すか

を選べます。"auto bracket"オプションは、連桁のかかった音符を隠し、連符が連桁の

かかっていない音符や休符を含む場合に括弧を表示します。

声部

声部は、１つの譜表に同時に始まるが異なる長さである複数の音符を持たせることを可

能にします。声部は他の記譜ソフトウェアでは、時には「レイヤー」と呼ばれています。
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手引き

1. まず第一声部（すべて上向き符尾の音符）を入力して開始してください。

2. 音符を入力するとき、そのいくつかは下向き符尾になるかもしれません。バージョ

ン0.9.4以降を使用している場合は、第二声部の追加時に自動的に反転するので、

子の時点での符尾の方向に心配する必要はありません。

3. 次に、その小節線の最初までカーソルを移動するために最初の音符を選択してく

ださい。

4. "Voice 2"ボタン を選択し、第二声部（すべて下向き符尾の音符）の入力を始

めてください。

5. 操作後にはこのように見えるはずです。

声部を使うケース

• １段の譜表の１つの和声の中に異なる方向を向いた符尾が必要な場合

• １段の譜表の中で、同時に演奏される異なる長さの音符が必要な場合

スペーサーの休符を隠す

休符を隠すには、その休符で右クリックしSet Invisibleを選択してください。Display →

 Show Invisibleにマークがついていれば、その休符はスクリーン上ではまだグレーに表

示されています。 その隠された休符は印刷するときには表示されません。

反復記号

反復記号（Volta）の括弧、あるいは１番括弧、２番括弧（first and second ending）

の括弧は、繰り返しの際に異なる終止を指定するのに使われます。

反復記号の括弧をスコアに配置するために、linesパレットからその項目をドラッグ・

アンド・ドロップしてください。

括弧は１小節以上またぐことができます。編集モードに入るために反復記号をダブルク

リックし、次に以下の操作でハンドルを移動させてください。

• １小節右へShift+Right

• １小節左へShift+Left
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これらのコマンドは、括弧のつく小節を決める反復記号の"論理的な"始点または終点を

移動します。Other commands in 編集モードでの他のコマンドはハンドルも動かします

が、繰り返しをどう演奏するかは変化させません。

ハンドルを移動する場合、論理位置から実際の位置までの破線は、次のように表示され

ます。

テキスト

Line Propertiesダイアログを用いて、反復記号括弧のテキストや他のプロパティを変

更することができます。反復記号括弧で右クリックし、Line Properties...を選んでくだ

さい。バージョン0.9.3以前を使っている場合には、"Volta Properties..."を選択して

ください。以下の図では、反復記号のテキストを"1.-5."と表示させています。

プレイバック

時には、繰り返しを２回以上演奏することがあります。上の図では、反復記号のテキス

トは次に行く前に５回演奏すべきということを指示しています。MuseScoreが繰り返し

を演奏する回数を変更したい場合には、繰り返しの小節線を含む小節に移動し、そのRe

peat Countを変更してください（詳しくは小節の操作を参照）。

バージョン0.9.4以前では、複数パートスコアの最上段の譜表にしか反復記号を配置す

ることができません。そうでないと、パートを作成したときにMuseScoreがクラッシュ

する（バグレポート参照）や、スコアを再読み込みしたときアンカー位置が移動してい

るようなバグ遭ってしまうかもしれません。

http://www.musescore.org/en/node/1257
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章4

音声とプレイバック

MuseScoreには"音声とプレイバック"機能が組み込まれています。 この章では、プレイ

バックコントロールと組み込みのピアノ音声を超えて楽器音声を拡張する方法について

扱います。

再生モード

MuseScoreは、スコアの再生のために統合シーケンサーを実装しています。再生 ボ

タンを押すことによって、再生モード（Play mode）に入ります。再生モードでは、次

のコマンドが使用可能です。

• 再生Ctrl+Space 

• 一時停止/再生の切り替えSpace

• 前のコードへLeft

• 次のコードへRight

• 前の小節へCtrl+Left

• 次の小節へCtrl+Right

• スコアの最初まで巻き戻すHome

• 再生パネルの表示切替F11

停止するためにもう一度再生ボタンを押し、再生モードを終了してください。

MuseScoreは、プレイバックを前に止めた場所から始めます。音符を選択した場合には、

MuseScoreはその代わりに新しく選択された音符から再生を開始します。ツールバー

には、プレイバックをスコアの最初へすばやく戻るための巻き戻しボタンもあります。

 

再生パネル（Play Panel）

再生パネルでは、テンポ、開始位置、全体の音量を含む制御が提供されています。メイ

ンメニューから、再生パネルを開くためにDisplay → Play Panelを選択してください。
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トラブルシューティング

バージョン0.9.5以降: ピアノ以外の楽器を再生したい場合には、MuseScoreに統合され

たサウンドフォントを、Edit → Preferences... → I/Oタブから、より高機能なものに変

更しなくてはいけません。構成方法についてはサウンドフォントを参照してください。

Ubuntuでのサウンド

Ubuntuでのサウンドに問題を生じた場合には、インストールの見出し"Linux"を参照し

てください。

サウンドフォント

MuseScoreでは、プレイバックのためにピアノ音が付属しています。さらに多くの音、

例えばバイオリンや打楽器を使うためには、General MIDIサウンドフォントが必要です。

概要

サウンドフォントファイルには楽器の音をいくつでも収納できます。多くのサウンドフォ

ントはウェブから利用可能です。General MIDI（GM）の１２８音源をカバーするもの

を探してください。General MIDI標準に準拠していないサウンドフォントを用いる場合

には、スコアを共有したりMIDIとして保存すると他の人には正しい楽器音には聞こえな

いかもしれません。

ウェブで入手できるサウンドフォントのファイルサイズと音質は様々です。大きなサウ

ンドフォントは良い音であることが多いですが、あなたのコンピュータで実行するには

大きすぎるかもしれません。大きなサウンドフォントのインストール後にMuseScoreの

実行が遅くなったり、あるいはプレイバックを保持できなくなった場合には、小さなサ

ウンドフォントを探してください。次に挙げるのは、広く普及している３種のサイズの

異なるGMサウンドフォントです。

• FluidR3_GM.sf2（141 MB 非圧縮）Fluid-soundfont.tar.gz (129 MB)からダウン

ロードできます。

• MagicSF_ver2.sf2（67.8 MB 非圧縮）Big SoundFontsを参照してください。

• TimGM6mb.sf2（5.7 MB 非圧縮)Tim Brechbill's Timidity++ Download Siteの"Fr

ee SoundFont" sectionを参照してください。

圧縮

http://ja.wikipedia.org/wiki/general_midi
http://www.musescore.org/download/fluid-soundfont.tar.gz
http://www.personalcopy.com/sfarkfonts1.htm
http://ocmnet.com/saxguru/timidity.htm#sf2
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サウンドフォントファイルは大きいため、.zip、.sfArk、.tar.gzを含む様々なフォー

マットで圧縮されていることがあります。使用する前にそれらのファイルを解凍する必

要があります。

• ZIPはほとんどのオペレーティング・システムでサポートされている標準的な圧縮

フォーマットです。

• sfArkはサウンドフォントファイルを圧縮するために特別に設計された圧縮フォー

マットです。これを解凍するには、特殊なsfArkソフトウェアを使用してください。

• .tar.gzはLinuxで広く普及している圧縮フォーマットです。Windowsユーザーは、

幅広い圧縮フォーマットをサポートする7-zip を使用することができます。Gzipを

１回、TARを１回の計２回の解凍が必要なことに注意してください。

MuseScoreの設定

サウンドフォントを見つけて解凍した後に、MuseScoreを設定する前に開こうとしてダ

ブルクリックしないでください。代わりに、ファイルを任意のフォルダに移動し、次の

ような手順に沿ってください。

Display → Synthesizerへと進んでください。 バージョン0.9.5以前を使用している場合

には、Edit → Preferences... → I/O タブへと進んでください。

初期のサウンドフォント設定は:/data/piano1.sf2です。これを新しいサウンドフォ

ント（.sf2）の場所に置き換えてください。ファイルを探して開くためにOpenアイコン

をクリックしてください。

preferencesパネルを閉じるためにOKをクリックして変更を適用してください。変更の

効果を得るには、MuseScoreを終了し再起動してください。

トラブルシューティング

再生パネルのツールバーがグレーになって機能しない、あるいは見えない場合には、サ

ウンドの再有効化のため次の手順に従ってください。

1. Display → Transportのメニュー項目にチェックマークがついているか確かめてく

ださい。対応するメニュー項目をクリックすると、チェックマークをつけたりはず

したりできます。このステップで問題が解決しない場合、次のステップを続けてく

ださい。

2. サウンドフォントの変更後、再生パネルが消えた場合、Edit → Preferences... → 

I/Oタブへ移動して、何の変更もしないままOKをクリックしてください。MuseScore

の再起動後に再生パネルが再表示されるはずです。これは0.9.3以前で判明してい

るバグです。

サウンドフォントを初めて設定する場合は、上記で推薦するサウンドフォントのうちか

ら１つを使用してください。

テンポ

http://www.melodymachine.com/sfark.htm
http://www.7-zip.org/
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プレイバックのテンポは、再生パネルまたはスコア内のテンポテキストで変更すること

ができます。

再生パネル（play panel）

• 再生パネルの表示: Display → Play Panel

• テンポ（Tmp）スライダーを使って、１秒当たりの拍数（bpm）を変更してくださ

い。slider

テンポテキスト（Tempo text）

• テンポテキストを作成する場所を指示するため、音符を選択してください。

• メインメニューからCreate → Text... → Tempo...を選択してください。

• 終了するためにOKを押してください。

バージョン0.9.3以前では、初期テンポテキスト・ダイアログからはテンポテキストま

たはBPMを変更することは不可能であることに注意してください。しかし、テンポテキ

ストをスコアに追加した後で、両方とも変更することができます。

既にあるテンポテキストは、編集モードに入るためにテキストをダブルクリックするこ

とで変更することができます。テンポテキストに４分音符やメトロノーム記号の他の速

度を追加するために、F2パレットを使用できます。

既にあるテンポテキストの１秒当たりの拍数（BPM）は、テキスト上で右クリックしTemp

o Properties...を選択することで調節できます。

注意: スコア上のテンポテキストは再生パネルでのテンポ設定を上書きします。

サウンドの変更と調節

ミキサー（Mixer）

ミキサーでは、各譜表について、楽器音の変更、音量・パンニング（音の定位）・リバー

ブ・コーラスの調節ができます。ミキサーを表示するには、メインメニューからDispl

ay → Mixerを選んでください。

消音（Mute）とソロ（Solo）

Muteチェックボックスは、特定の譜表をすぐに消音させます。もう１つの方法として、S

oloチェックボックスは"solo"としてマークした譜表を除いたすべての譜表を消音させる

のに使います。

ダイヤル
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ダイヤルを時計回りに回すには、クリックして上方向へドラッグしてください。ダイヤ

ルを反時計回りに回すには、クリックして下方向へドラッグしてください。 

サウンド（Sound）

サウンドのドロップダウン・メニューには、現在のサウンドフォントでサポートされる

全ての楽器がリストされます。この機能はWindows版バージョン0.9.4以前では実装され

ていませんが、バージョン0.9.5でバグ・フィックスされました。

譜表の途中での変更

MuseScoreでは、曲の途中で楽器の音色を変更することができます。例えば、弦楽器の

音をピチカートあやトレモロに、トランペットの音をミュート・トランペットに変更で

きます。次の手順ではミュート・トランペットの例を用いていますが、同様の法則は弦

楽器のピチカートやトレモロに応用されます。

1. 消音する範囲の最初の音符を選択してください。

2. メインメニューからCreate → Text → Staff Textを選んでください。

3. Mute（またはCon Sordinoのような同じ意味の指示）とタイプしてください。この時

点では、譜表のテキストは人のためのもので、MuseScoreでのプレイバックに影響

を与えません。

4. 譜表のテキスト上で右クリックし、Staff Text Properties...を選択してください。

5. Staff Text PropertiesダイアログでChannelチェックボックスをマークしてくださ

い。

6. Staff Text Propertiesダイアログでmuteを選択してください。

7. スコアに戻るためにOKをクリックしてください。

あなたの加えた譜表テキスト以降では、すべての音符はミュートされます。曲中でミュー

トされない音にもどるためには、ステップ３でOpenとタイプし、ステップ６でnormal

を選択することを除き、上述と同様のガイドラインにしたがってください。
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章5

テキスト

この"テキスト"の章では、歌詞、コードネーム、その他の譜表のテキストを扱います。

前の章では、プレイバック時のテンポに影響を与えるテキストを扱いました。

テキスト編集

編集モードに入るためにテキスト上でダブルクリックします。

テキスト編集モードでは、次のコマンドが利用可能です。

• Ctrl+B（Mac: ⌘+B）太字体への切り替え

• Ctrl+I（Mac: ⌘+I）斜体への切り替え

• Ctrl+U（Mac: ⌘+U）下線への切り替え

• Up上付きの入力開始、または、下付きモード時には下付き入力の終了

• Down下付きの入力開始、または、上付きモード時には上付き入力の終了

• カーソルの移動: Home End Left Right

• Backspaceカーソルの左側から文字を削除する。

• Deleteカーソルの右側から文字を削除する。

• Return新しい行を始める。

• F2テキストパレットの表示。テキストパレットは、特殊文字と特殊記号の入力に使

用できる。

テキストパレット:
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関連項目: コードネーム, 歌詞, フレーム, 編集モード

テキストスタイル

テキストの要素はテキストスタイルから作成します。このスタイルはテキストの初期プ

ロパティを定義します。

テキストのプロパティ:

• フォントの種類（Font Family）: "Times New Roman"や"Arial"のようなフォント

の名前

• ポイントサイズ（Point Size）: ポイント単位でのフォントの大きさ

• 斜体（Italic）、太字体（Bold）、下線（Underline）: フォントのプロパティ

• アンカー（Anchor）: ページ、拍子、符頭、譜表全体、譜表

• 配置（Alignment）: 水平方向（horizontal）: 左、右、中央揃え; 垂直方向（ve

rtical）: 上、下、中央揃え

• オフセット（Offset）: 通常のアンカーポジションに対するオフセット長

• オフセットタイプ（Offset Type）: mm、スペース、ページサイズに対するパーセ

ント

テキストタイプ:

• タイトル（Title）、サブタイトル（Subtitle）、作曲者名（Composer）、作詞者

名（Poet）: ページにアンカーされる。

• 運指（Fingering）: 運指は符頭にアンカーされる。

• 歌詞（Lyrics）: 歌詞は拍子の位置にアンカーされる。

• コードネーム（Chord name）: コードネームも拍子の位置にアンカーされる。

コードネーム
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コードネーム（Chord name）は、まず音符を選択し、Ctrl+Kを押すことで入力できます。

これは選択されたコードのためのコードネームのテキストを作成します。

• 次のコードに移動するためには、Spaceをタイプしてください。

• Shift+Spaceで前のコードに移動します。

• Ctrl+Spaceは、コードネームのテキスト内に空白を入力します。

コードネームは、通常のテキストとして編集できます。シャープを加えるためには#を、

フラットを加えるためにはbをタイプしてください。次のコードに移る際、これらの文字

は自動的に適切なシャープやフラット記号に変わります。

Jazzフォント

スコアに手書き風のコードネームを好むなら、バージョン0.9.5以降がこのオプション

を含んでいます。

1. メインメニューからStyle → Edit Style...を選んでください。

2. 左側のペインでChord namesを選んでください。

3. 右側のペインでchords.xmlとjazzchords.xmlのテキストを置き換えてください。

運指

運指（Fingering）は、Fingeringパレットからスコアの符頭へ、運指文字をドラッグす

ることで音符に追加できる。運指は、他のテキスト同様に編集できる通常のテキストで

ある。

歌詞

1. まず音符を入力します。

2. 最初の音符を選択してください。

3. Ctrl+Lをタイプし、最初の音符に対する歌詞を入力してください。

4. 次の音符に移るために、語の最後でSpaceをタイプしてください。

5. 次の音符に移るために、音節の最後でハイフン-をタイプしてください。 この音

節はダッシュで結ばれます。
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6. Shift+Spaceで前の音符へ移動します。

音節は下線で伸ばすことができます。

次のように入力してください: soul, _ _ _ Esc

特殊文字

歌詞は、いつかの文字を除いて通常の文字のように編集できます。一つの音節に空白、

ハイフンあるいはアンダースコアを加えたい場合には、次のショートカットを使用して

ください。

• Ctrl+Space（Mac: ⌥+Space）はspaceを歌詞に入力します。

• Ctrl+-（Mac: ⌥+-）はハイフン（-）を歌詞に入力します。

• Macのみ: ⌥+_はアンダースコア（_）を歌詞テキストに入力します。

関連項目: テキスト、コードネーム.
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章6

フォーマット

ブレークとスペーサー

改ページまたは改行（譜表の分割）はブレークパレットから、対応する記号（break li

neまたはbreak page）をスコアの空白部分へドラッグすることにより適用できます。分

割は、記号を置いた小節の直後に設定されます。緑色の分割記号はスクリーン上に表示

されますが、印刷物には現れません。

スペーサー(spacer)は、隣り合う２つの上下の譜表間の空白を増やすために用います。

スペーサーを、垂直方向の空白がさらに必要な領域の上の小節へドラッグ・アンド・ド

ロップしてください。スペーサーをダブルクリックして、スペーサーの高さを調節する

ためにマウスでハンドルをドラッグしてください。

譜表間の空白、スコア幅を調節したい場合には、スタイル設定を使用してください。ス

ペーサーは小さな部分の調節のために設計されています。

フレーム

フレームは通常の小節外側に空白を与えます。そこにはテキストや図も含めることがで

きます。MuseScoreには２種類のフレームがあります。 

水平フレーム
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水平フレームは譜表を分割します。幅は調

節可能で、高さは譜表の高さと等しくなります。水平フレームはコーダを分割する

ために用いることができます。

垂直フレーム

垂直フレームは譜表の間か直前に空白を与

えます。高さは調節可能で、幅は譜表の幅と等しくなります。垂直フレームはタイ

トル、サブタイトルあるいは作曲者名を配置するために用いられます。タイトルを

作成する場合、垂直フレームは最初の小節の直前に（もし小節が無くても）自動的

に配置されます。

フレームの作成

まず小節を選択します。メニューのCreate → Measuresにフレームを挿入するためのコマ

ンドが現れます。選択した小節の直前にフレームが挿入されます。

フレームの削除

フレームを選択し、Delを押してください。

フレームの編集

フレームをダブルクリックすると編集モードに入ります。フレームのサイズをドラッグ

するために使うハンドルが表示されます。

編集モードにおけるタイトルフレーム:
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章7

サポート

この章では、MuseScoreの使い方についてのヘルプを探す方法を述べます。見るべき最

善の場所、フォーラムで質問する最善の方法、バグを報告するための秘訣が含まれます。

バグを報告する / サポートを依頼する

サポートの要求をフォーラムに投稿する前に:

• ハンドブックに解決策がないか探してください！

• フォーラムで他の誰かが既に同じ問題に遭遇していないか見るために、ウェブサ

イトのsearch機能を使ってください。

• エラー報告を投稿する場合には、まず最新プレリリースでその問題が再現される

か試してください。 既に解決されていないかチェックするため、version history

も見たほうがよいでしょう。

サポートの要求あるいはバグ報告を投稿するときは、あなたの知りうる以下の情報を十

分に含むようにしてください。

• 使用しているMuseScoreバージョン（例 version 0.9.5）あるいはプレリリース版

を使用している場合には、リビジョン・ナンバー（例 revision 1944）

• 実行しているオペレーティング・システム（例 Windows Vista、Mac OS 10.5、Ub

untu 9.04）

• バグを報告する場合、その問題に至る正確なステップを記述してください（どこ

をクリックしたのか、どのキーを押したのか、何を見るのか、など）。 もしその

ステップで問題を際限できない場合には、それは開発者も再現できない（解決でき

ない）ため、価値のある報告ではありません。

• issue trackerでは、あなたのレポートは、１レポートにつき１つのバグに制限し

てください。

• バグレポートの目標は、単にバグを示すことだけではなく、他の人がバグを簡単

に再現できるようにすることを覚えていてください。

http://musescore.org/ja/forum
http://musescore.org/ja/ハンドブック
http://musescore.org/ja/forum
http://musescore.org/en/search
http://musescore.org/en/download
http://mscore.svn.sourceforge.net/viewvc/mscore/trunk/mscore/changelog
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初期設定に戻す

MuseScoreの最新バージョンには、標準に組み込まれたプリセットあるいは"初期設定（

factory-settings）"に復旧するオプションがあります。設定が破損した場合には、こ

の機能は役立つことがあります。すべてをリセットしないで問題を解決するための方法

があるかもしれないので、はじめにフォーラムに相談することがベストですんで、この

状況はふつうには起こりません。

注意:"初期設定"への復旧は preferences、palettesまたはwindow設定に行ったすべて

の変更を消去します。

Windowsでの手順

1. MuseScoreを開いている場合、まず閉じる必要があります。

2. ファイル名を指定して実行ダイアログを開くために、Windowsキー+Rをタイプしてく

ださい。（The WindowsキーはMicrosoft Windowsロゴを持つキーです。）

3. 参照（B）...をクリックしてください。

4. あなたのコンピュータ上のmscore.exeを探してください。この場所はあなたのし

たインストール作業によって変わるでしょうが、おそらくマイコンピュータ > ロー

カルディスク > Program Files > MuseScore 0.9 > bin > mscore.exeと似た場

所にあります。

5. 参照ダイアログから出てファイル名を指定して実行ダイアログに戻るために、開く

をクリックしてください。次のテキスト（あるいは似たもの）がファイル名を指定

して実行ダイアログに表示されるはずです。"C:\Program Files\MuseScore 0.

9\bin\mscore.exe"

6. 末尾の二重引用符の後をクリックして、ハイフンに続いて大文字のFを入力してく

ださい。（訳注: 必ず日本語入力をオフにし、-Fの前には半角スペースが入るよう

にしてください。）-F

7. OKを押してください。 

数秒後、MuseScoreが開始され、すべての設定が"factory settings"に復旧します。

Mac OSXでの手順

1. MuseScoreを開いている場合、まず閉じる必要があります。（⌘+Q）

2. Applications/Utilities/Terminalを開き、Terminalセッションのウィンドウを表

示してください。

3. 以下のコマンドをターミナルにタイプ（もしくは単にコピー・ペースト）してく

ださい。（行頭に'/'を含めます。） 

/Applications/MuseScore.app/Contents/MacOS/mscore -F

依据 Creative Commons Attribution 3.0 授权发布，2002-2010 Werner Schweer 等。 

http://ja.wikipedia.org/wiki/windowsキー
http://creativecommons.org/licenses/by/3.0/deed.zh
mailto:ws@seh.de
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